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Creating Figures as an Intro to RCreating Figures as an Intro to R
Using the ggplot2 package

Wrapping up: Further reading (all Wrapping up: Further reading (all FreeFree!)!)
RStudio > Help > Cheatsheets > Data Visualization with ggplot2

 (Hadley Wickham, Danielle Navarro, and Thomas Lin Pedersen)

 (Winston Chang)

 (Hadley Wickham & Garrett Grolemund)

 (Kieran Healy)

ggplot2 book v3

patchwork website

Cookbook for R

R for Data Science
Chp 3 Data Visualization

Data Visualization: A practical introduction

https://ggplot2-book.org/
https://patchwork.data-imaginist.com/
http://www.cookbook-r.com/
https://r4ds.had.co.nz/
http://r4ds.had.co.nz/data-visualisation.html
http://socviz.co/
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PreamblePreamble
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Online workshops can be challengingOnline workshops can be challenging
Consider keeping your video on (if possible)

Kids? Pets? Spouses? No problem
But ultimately, you need be comfortable! (and you absolutely have the right to privacy)

Interrupt me!
Generally keep yourself muted but un-mute anytime to ask questions

Ask Questions!
Group trouble-shooting is really valuable
If you have a problem, others may also (or may have it in the future)

Screen-sharing
I may ask you to share your screen with the group (feel free to decline)

For privacy, close your email etc. Or just share your RStudio window
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This is me and my creaturesThis is me and my creatures
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This is my gardenThis is my garden

6



What about you?What about you?
Name
Background (Role, Area of study, etc.)
Familiarity with R or Programming
Creatures (furry, feathery, scaley, green or otherwise)?
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OutlineOutline
1. A little about R

2. Creating figures with ggplot2

3. Combining figures with patchwork

4. Saving figures

Taken this or a similar workshop before?

During activities consider…

Extra activities labeled “Too Easy?”
Using your own data
Exploring other aspects of ggplot2 that interest you

Feel free to ask questions even if it’s not the “official” activity!
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What is R?What is R?
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R is a Programming languageR is a Programming language

You need to know the language (i.e., the code)
Computers don’t know what you mean, only what you type (unfortunately)
Spelling, punctuation, and capitalization all matter!

For example
R, what is 56 times 5.8?

A programming language is a way to give instructions in order to get a computer to do something

56 * 5.8
[1] 324.8
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Use code to tell R what to doUse code to tell R what to do

R, what is the average of numbers 1, 2, 3, 4?
mean(c(1, 2, 3, 4))
[1] 2.5

R, save this value for later
steffis_mean <- mean(c(1, 2, 3, 4))

R, multiply this value by 6
steffis_mean * 6
[1] 15
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Why R?Why R?
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R is hardR is hard
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But R is powerful (and reproducible)!But R is powerful (and reproducible)!
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R is also beautifulR is also beautiful
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R is affordable (i.e., free!)R is affordable (i.e., free!)
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ImpostImpostRR Syndrome Syndrome
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ImpostImpostRR Syndrome Syndrome
 

 

Moral of the story?
Make friends, code in groups, learn together and don’t beat yourself up
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The GoalThe Goal
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About RAbout R
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Code, Output, ScriptsCode, Output, Scripts
Code

The actual commands

Output
The result of running code or a script

Script
A text file full of code that you want to run
You should always keep your code in a script

For example:
mean(c(1, 2, 3, 4))
[1] 2.5

Code
Output

Script
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RStudio vs. RRStudio vs. R

RStudio is not R
RStudio is a User Interface or IDE (integrated development environment)

(i.e., Makes coding simpler)

 

RStudio

 

R
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functions()functions() - Do things, Return things - Do things, Return things

mean(), read_csv(), ggplot(), c(), etc.
Always have ()
Can take arguments (think ‘options’)

mean(x = c(2, 10, 45)),
mean(x = c(NA, 10, 2, 65), na.rm = TRUE)

Arguments defined by name or by position
With correct position, do not need to specify by name

By name: By position:
mean(x = c(1, 5, 10))
[1] 5.333333

mean(c(1, 5, 10))
[1] 5.333333
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R documentationR documentation
?mean1
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DataData
Generally kept in vectors or data.frames

These are objects with names (like functions)
We can use <- to assign values to objects (assignment)

Vector (1 dimension) Data frame (2 dimensions)
my_data <- c("a", 100, "c")
my_data
[1] "a"   "100" "c"  

my_data <- data.frame(site = c("s1", "s2", "s3"),
                      count = c(101, 102, 103),
                      treatment = c("a", "b", "c"))
my_data
  site count treatment
1   s1   101         a
2   s2   102         b
3   s3   103         c

rows x columns
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Your first Your first realreal code! code!
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First CodeFirst Code

1. Copy/paste or type this into the script window in RStudio
You may have to go to File > New File > R Script

2. Click on the first line of code

3. Run the code
Click ‘Run’ button (upper right) or
Use the short-cut Ctrl-Enter

4. Repeat until all the code has run

# First load the packages1
library(palmerpenguins)2
library(ggplot2)3

4
# Now create the figure5
ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour = species)) +6
  geom_point()7
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First CodeFirst Code
# First load the packages1
library(palmerpenguins)2
library(ggplot2)3

4
# Now create the figure5
ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour = species)) +6
  geom_point()7

Warning: Removed 2 rows containing missing values (`geom_point()`).
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First CodeFirst Code
# First load the packages1
library(palmerpenguins)2
library(ggplot2)3

4
# Now create the figure5
ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour = species)) +6
  geom_point()7

Warning: Removed 2 rows containing missing values (`geom_point()`).

Packages
ggplot2 and palmerpenguins
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First CodeFirst Code
# First load the packages1
library(palmerpenguins)2
library(ggplot2)3

4
# Now create the figure5
ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour = species)) +6
  geom_point()7

Warning: Removed 2 rows containing missing values (`geom_point()`).

Functions
library(), ggplot(), aes(), geom_point()
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First CodeFirst Code
# First load the packages1
library(palmerpenguins)2
library(ggplot2)3

4
# Now create the figure5
ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour = species)) +6
  geom_point()7

Warning: Removed 2 rows containing missing values (`geom_point()`).

+
(Specific to ggplot)
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First CodeFirst Code
# First load the packages1
library(palmerpenguins)2
library(ggplot2)3

4
# Now create the figure5
ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour = species)) +6
  geom_point()7

Warning: Removed 2 rows containing missing values (`geom_point()`).

Figure!
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First CodeFirst Code
# First load the packages1
library(palmerpenguins)2
library(ggplot2)3

4
# Now create the figure5
ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour = species)) +6
  geom_point()7

Warning: Removed 2 rows containing missing values (`geom_point()`).
Warning
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First CodeFirst Code
# First load the packages1
library(palmerpenguins)2
library(ggplot2)3

4
# Now create the figure5
ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour = species)) +6
  geom_point()7

Warning: Removed 2 rows containing missing values (`geom_point()`).

Comments
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Now you know R!Now you know R!
Let’s get started
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Our data set: Palmer Penguins!Our data set: Palmer Penguins!
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Our data set: Palmer Penguins!Our data set: Palmer Penguins!
library(palmerpenguins)1
penguins2

# A tibble: 344 × 8
   species island    bill_length_mm bill_depth_mm flipper_length_mm body_mass_g sex     year
   <fct>   <fct>              <dbl>         <dbl>             <int>       <int> <fct>  <int>
 1 Adelie  Torgersen           39.1          18.7               181        3750 male    2007
 2 Adelie  Torgersen           39.5          17.4               186        3800 female  2007
 3 Adelie  Torgersen           40.3          18                 195        3250 female  2007
 4 Adelie  Torgersen           NA            NA                  NA          NA <NA>    2007
 5 Adelie  Torgersen           36.7          19.3               193        3450 female  2007
 6 Adelie  Torgersen           39.3          20.6               190        3650 male    2007
 7 Adelie  Torgersen           38.9          17.8               181        3625 female  2007
 8 Adelie  Torgersen           39.2          19.6               195        4675 male    2007
 9 Adelie  Torgersen           34.1          18.1               193        3475 <NA>    2007
10 Adelie  Torgersen           42            20.2               190        4250 <NA>    2007
# ℹ 334 more rows

Your turn!

Run this code and look at the output in the console
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A basic plotA basic plot
library(palmerpenguins)1
library(ggplot2)2

3
ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm)) +4
    geom_point()5
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Break it downBreak it down

library(palmerpenguins)
Load the palmerguins package
Now we have access to penguins data

library(palmerpenguins)1
library(ggplot2)2

3
ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm)) +4
    geom_point()5
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Break it downBreak it down

library(ggplot2)
Load the ggplot2 package
Now we have access to the ggplot() function

(and aes() and geom_point() etc.)

library(palmerpenguins)1
library(ggplot2)2

3
ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm)) +4
    geom_point()5
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Break it downBreak it down

ggplot()
Set the attributes of your plot
data = Dataset
aes = Aesthetics (how the data are used)
Think of this as your plot defaults

library(palmerpenguins)1
library(ggplot2)2

3
ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm)) +4
    geom_point()5
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Break it downBreak it down

geom_point()
Choose a geom function to display the data
Always added to a ggplot() call with +

library(palmerpenguins)1
library(ggplot2)2

3
ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm)) +4
    geom_point()5

ggplots are essentially layered objects, starting with a
call to ggplot()

47



Plots are layeredPlots are layered
ggplot(data = penguins, aes(x = sex, y = body_mass_g))1 ggplot(data = penguins, aes(x = sex, y = body_mass_g)) +1

  geom_boxplot()2
ggplot(data = penguins, aes(x = sex, y = body_mass_g)) +1
  geom_point()2
ggplot(data = penguins, aes(x = sex, y = body_mass_g)) +1
  geom_violin()2
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Plots are layeredPlots are layered
You can add multiple layers

ggplot(data = penguins, aes(x = sex, y = body_mass_g)) +1
  geom_boxplot()2

ggplot(data = penguins, aes(x = sex, y = body_mass_g)) +1
  geom_boxplot() +2
  geom_point(size = 2, colour = "red")3

Order matters
ggplot(data = penguins, aes(x = sex, y = body_mass_g)) +1
  geom_point(size = 2, colour = "red") +2
  geom_boxplot()3
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Plots are objectsPlots are objects
Any ggplot can be saved as an object

g <- ggplot(data = penguins, aes(x = sex, y = body_mass_g))1

g1 g + geom_boxplot()1
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More GeomsMore Geoms
(Plot types)
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Geoms: LinesGeoms: Lines
ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm)) +1
  geom_line()2
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Geoms: HistogramGeoms: Histogram
ggplot(data = penguins, aes(x = body_mass_g)) +1
  geom_histogram(binwidth = 100)2

Note: We only need 1 aesthetic here
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Geoms: BarplotsGeoms: Barplots
Let ggplot count your data

ggplot(data = penguins, aes(x = sex)) +1
  geom_bar()2
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Geoms: BarplotsGeoms: Barplots
You can also provide the counts

# Create our own data frame1
species_counts <- data.frame(species = c("Adelie", "Chinstrap", "Gentoo"),2
                             n = c(152, 68, 124))3

4
ggplot(data = species_counts, aes(x = species, y = n)) +5
  geom_bar(stat = "identity")6
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Your Turn: Create this plotYour Turn: Create this plot
library(ggplot2)1

2
ggplot(data = ____, aes(x = ____, y = ____)) +3
  geom_____(____)4
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Your Turn: Create this plotYour Turn: Create this plot
library(ggplot2)1

2
ggplot(data = penguins, aes(x = island, y = bill_depth_mm)) +3
  geom_boxplot(colour = "blue")4
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Showing data by groupShowing data by group
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Mapping aestheticsMapping aesthetics
ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm)) +1
  geom_point()2
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Mapping aestheticsMapping aesthetics
ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour = sex)) +1
  geom_point()2

colour = sex

62



Mapping aestheticsMapping aesthetics
ggplot automatically populates the legends (combining where it can)

ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour = sex, shape = sex)) +1
  geom_point()2
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Faceting: Faceting: facet_wrap()facet_wrap()
ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour = sex)) +1
  geom_point() +2
  facet_wrap(~ species)3

Split plots by one grouping variable
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Faceting: Faceting: facet_grid()facet_grid()
ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour = sex)) +1
  geom_point() +2
  facet_grid(sex ~ species)3

Split plots by two grouping variables
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Your Turn: Create this plotYour Turn: Create this plot
ggplot(data = ____, aes(_____________________________________)) +1
  ______________ +2
  ______________3

Hint: colour is for outlining with a colour, fill is for ‘filling’ with a colour
Too Easy? Split boxplots by sex and island
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Your Turn: Create this plotYour Turn: Create this plot
ggplot(data = penguins, aes(x = sex, y = flipper_length_mm, fill = sex)) +1
  geom_boxplot() +2
  facet_wrap(~ species)3

Hint: colour is for outlining with a colour, fill is for ‘filling’ with a colour
Too Easy? Split boxplots by sex and island
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Your Turn: Create this plotYour Turn: Create this plot
Too Easy?

ggplot(data = penguins, aes(x = sex, y = flipper_length_mm, fill = island)) +1
  geom_boxplot() +2
  facet_wrap(~ species)3

Small change (fill = sex to fill = island) results in completely different plot
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Trendlines / Regression LinesTrendlines / Regression Lines
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Trendlines / Regression linesTrendlines / Regression lines
geom_line() is connect-the-dots, not a trend or linear model

ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm)) +1
  geom_point() +2
  geom_line()3

Not what we’re looking for
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Trendlines / Regression linesTrendlines / Regression lines
Let’s add a trend line properly
Start with basic plot:

g <- ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm)) +1
  geom_point()2
g3
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Trendlines / Regression linesTrendlines / Regression lines
Add the stat_smooth()
lm is for “linear model” (i.e. trendline)
grey ribbon = standard error

g + stat_smooth(method = "lm")1
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Trendlines / Regression linesTrendlines / Regression lines
Add the stat_smooth()

remove the grey ribbon se = FALSE

g + stat_smooth(method = "lm", se = FALSE)1
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Trendlines / Regression linesTrendlines / Regression lines
A line for each group

Specify group (here we use colour to specify species)

g <- ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour = species)) +1
  geom_point()2
g3
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Trendlines / Regression linesTrendlines / Regression lines
A line for each group
stat_smooth() automatically uses the same grouping

g + stat_smooth(method = "lm", se = FALSE)1
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Trendlines / Regression linesTrendlines / Regression lines
A line for each group AND overall

g +1
  stat_smooth(method = "lm", se = FALSE) +2
  stat_smooth(method = "lm", se = FALSE, colour = "black")3
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Your Turn: Create this plotYour Turn: Create this plot
A scatter plot: Flipper Length by Body Mass grouped by Species
With a single regression line for the overall trend

Too Easy? Create a separate plot for each sex as well
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Your Turn: Create this plotYour Turn: Create this plot
A scatter plot: Flipper Length by Body Mass grouped by Species
With a single regression line for the overall trend

ggplot(data = penguins, aes(x = body_mass_g, y = flipper_length_mm, colour = species)) +1
  geom_point() +2
  stat_smooth(se = FALSE, colour = "black", method = "lm")3
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Your Turn: Create this plotYour Turn: Create this plot
Too Easy?

ggplot(data = penguins, aes(x = body_mass_g, y = flipper_length_mm, colour = species)) +1
  geom_point() +2
  stat_smooth(se = FALSE, colour = "black", method = "lm") +3
  facet_wrap(~sex)4
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Customizing plotsCustomizing plots
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Customizing: Starting plotCustomizing: Starting plot
Let’s work with this plot

g <- ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour = species)) +1
  geom_point()2
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Customizing: LabelsCustomizing: Labels
g + labs(title = "Bill Length vs. Body Mass",1
         x = "Body Mass (g)",2
         y = "Bill Length (mm)",3
         colour = "Species", tag = "A")4

Practice for later: Add proper labels to some of your previous plots
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Customizing: Built-in themesCustomizing: Built-in themes
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Customizing: AxesCustomizing: Axes
scale_ + (x or y) + type (continuous, discrete, date, datetime)

scale_x_continuous()
scale_y_discrete()
etc.

Common arguments
g + scale_x_continuous(breaks = seq(0, 20, 10)) # Tick breaks1
g + scale_x_continuous(limits = c(0, 15))       # xlim() is a shortcut for this2
g + scale_x_continuous(expand = c(0, 0))        # Space between axis and data3
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Customizing: AxesCustomizing: Axes
Breaks

g + scale_x_continuous(breaks = seq(2500, 6500, 500))1
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Customizing: AxesCustomizing: Axes
Limits

g + scale_x_continuous(limits = c(3000, 4000))1
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Customizing: AxesCustomizing: Axes
Space between origin and axis start

g + scale_x_continuous(expand = c(0, 0))1
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Customizing: AestheticsCustomizing: Aesthetics
Using scales
scale_ + aesthetic (colour, fill, size, etc.) + type (manual, continuous, datetime, etc.)

g + scale_colour_manual(name = "Type", values = c("green", "purple", "yellow"))1
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Customizing: AestheticsCustomizing: Aesthetics
Using scales
Or be very explicit:

g + scale_colour_manual(1
  name = "Type",2
  values = c("Adelie" = "green", "Gentoo" = "purple", "Chinstrap" = "yellow"),3
  na.value = "black")4
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Customizing: AestheticsCustomizing: Aesthetics
For colours, consider colour-blind-friendly scale
viridis_d for “discrete” data

ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour = species)) +1
  geom_point() +2
  scale_colour_viridis_d(name = "Type")3
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Customizing: AestheticsCustomizing: Aesthetics
For colours, consider colour-blind-friendly scale
viridis_c for “continuous” data

ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour = flipper_length_mm)) +1
  geom_point() +2
  scale_colour_viridis_c(name = "Flipper Length (mm)")3
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Customizing: AestheticsCustomizing: Aesthetics
Forcing
Remove the association between a variable and an aesthetic

ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour = sex)) +1
  geom_point(colour = "darkblue", size = 1) +2
  stat_smooth(method = "lm", se = FALSE, colour = "lightblue")3

Note: When forcing, aesthetic is not inside aes()

94



Customizing: Legends placementCustomizing: Legends placement



At the: top, bottom, le�, right Exactly here
g + theme(legend.position = "top")1 g + theme(legend.position = c(0.15, 0.7))1
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Combining plotsCombining plots
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Combining plots with Combining plots with patchworkpatchwork
Setup

Load patchwork
Create a couple of different plots

library(patchwork)1
2

g1 <- ggplot(data = penguins, aes(x = bill_length_mm, y = bill_depth_mm, colour = species)) +3
  geom_point()4

5
g2 <- ggplot(data = penguins, aes(x = species, y = flipper_length_mm)) +6
  geom_boxplot()7

8
g3 <- ggplot(data = penguins, aes(x = flipper_length_mm, y = body_mass_g, colour = species)) +9
  geom_point()10
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Combining plots with Combining plots with patchworkpatchwork
Side-by-Side 2 plots

g1 + g21
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Combining plots with Combining plots with patchworkpatchwork
Side-by-Side 3 plots

g1 + g2 + g31
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Combining plots with Combining plots with patchworkpatchwork
Stacked 2 plots

g1 / g21
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Combining plots with Combining plots with patchworkpatchwork
More complex arrangements

g2 + (g1 / g3)1
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Combining plots with Combining plots with patchworkpatchwork
More complex arrangements

g2 / (g1 + g3)1
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Combining plots with Combining plots with patchworkpatchwork
“collect” common legends

g2 / (g1 + g3) + plot_layout(guides = "collect")1
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Combining plots with Combining plots with patchworkpatchwork
“collect” common legends

g2 / (g1 + g3 + plot_layout(guides = "collect"))1
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Combining plots with Combining plots with patchworkpatchwork
Annotate

g2 / (g1 + g3) +1
  plot_layout(guides = "collect") +2
  plot_annotation(title = "Penguins Data Summary",3
                  caption = "Fig 1. Penguins Data Summary",4
                  tag_levels = "A",5
                  tag_suffix = ")")6
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Saving plotsSaving plots
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Saving plotsSaving plots
RStudio Export
Demo

ggsave()
g <- ggplot(penguins, aes(x = sex, y = bill_length_mm, fill = year)) +1
  geom_boxplot()2

3
ggsave(filename = "penguins_mass.png", plot = g)4
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Saving plotsSaving plots
Publication quality plots

Many publications require ‘lossless’ (pdf, svg, eps, ps) or high quality formats (tiff, png)
Specific sizes corresponding to columns widths
Minimum resolutions

g <- ggplot(penguins, aes(x = sex, y = body_mass_g)) +1
  geom_boxplot() +2
  labs(x = "Sex", y = "Body Mass (g)") +3
  theme(axis.text.x = element_text(angle = 45, hjust = 1))4

5
ggsave(filename = "penguins_mass.pdf", plot = g, dpi = 300,6
       height = 80, width = 129, units = "mm")7
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Wrapping upWrapping up
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Wrapping up: Common mistakesWrapping up: Common mistakes
The package is ggplot2, the function is just ggplot()

Did you remember to put the + at the end of the line?

Order matters!
If you’re using custom theme()’s, make sure you put these lines a�er bundled themes like theme_bw(), or
they will be overwritten

Variables like ‘year’ are treated as continuous, but are really categories
Wrap them in factor()
e.g. ggplot(data = penguins, aes(x = factor(year), y = body_mass_g))

113



Thank you!

 

✉ 

steffilazerte.ca

sel@steffilazerte.ca
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ExtraExtra
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Your Turn!Your Turn!
Create a figure with…

Custom colour mapping (i.e. scales_....)
Clear, human-readable labels
More than one graph, each one tagged (e.g., A) or B))
With more than one geom type
At least one scatterplot with regression line

w

OR… Load your own data and create a figure of your own!
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